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Mở đầu 
ORCAD là một công cụ thiết kế mạch điện tử đơn giản và phổ biến. Cũng có rất nhiều phần mềm thiết kế 
mạch điện tử khác, tuy nhiên, tôi chọn sử dụng phần mềm này, vì bộ công cụ này được đánh giá là khá 
mạnh. 
Các thư viện linh kiện của ORCAD có thể coi là mạnh nhất cho đến nay, và hầu hết các nhà sản xuất linh 
kiện điện tử đều cung cấp các add-in thư viện linh kiện cho ORCAD. 
 
Đã có rất nhiều sách hướng dẫn sử dụng ORCAD bằng hình, tuy nhiên giá sách khá cao và thực chất 
ORCAD không có gì là phức tạp, vì vậy, tôi muốn thực hiện tài liệu hướng dẫn này một cách đơn giản, để 
cung cấp miễn phí cho sinh viên. Thành thực mà nói, các sách dù có hướng dẫn tỉ mỉ tới đâu, thì cũng 
không thể giúp các bạn sinh viên nắm bắt toàn bộ các chức năng của ORCAD, mà chủ yếu, các bạn thực 
hành nhiều, mày mò nhiều, và hỏi han nhiều, các bạn sẽ tìm hiểu và nắm bắt về ORCAD rất dễ dàng. 
 
Trong tài liệu hướng dẫn này, chúng tôi sẽ đi từng bước đơn giản, để các bạn có thể thực hiện một mạch 
nguyên lý bằng ORCAD, sau đó hướng dẫn các bạn từng bước để xuất ra thành mạch in, chạy mạch in, 
điều chỉnh mạch in, cuối cùng là việc làm một mạch in điện tử tại nhà như thế nào. 
  
Tài liệu này được chia làm 5 phần: 
 -Phần 1. Cài đặt OrCAD 9.2 

 -Phần 2. Một số thao tác để vẽ một mạch nguyên lý với ORCAD dùng CAPTURE 

 -Phần 3. Cách chuyển từ mạch nguyên lý sang mạch in và các thao tác trên LAYOUT PLUS 

 -Phần 4. Sử dung công cụ Pspice A/D tích hợp trong OrCAD để mô phỏng mạch điện  

-Phần5. Một số mạch điện tử lý thú để các bạn nâng cao khả năng vẽ mạch của mình 

 -Phần 5. Làm  mạch in 1 lớp thủ công 

Ở đây tôi chọn sử dụng OrCAD 9.2 vì tính phổ biến của nó, thư viện khá đây đủ, chiếm ít tài nguyên, ít 

lỗi, sử dụng rất ổn định. Hiện tại đã có bản 16.5 nhưng rất nặng (10G tất cả sau khi cài đặt ), với lại việc 

cài đặt cũng rất khó khăn. Kể từ bản 16.3 trở đi Cadene đã bỏ phần Layout mà thay vào đó là PCB Editor, 

vì vậy tài liệu của phần này rất ít chủ yếu là tài liệu tiếng anh. Nhưng nếu muốn trở thành nhà Design 

PCB chuyên nghiệp thì nên sử dụng cái này. 

Cũng phải nói thêm rằng đây là tài liệu tôi biện soạn dựa trên những kiến thức của mình và trích dẫn 

tham khảo thêm một số tài liệu trên mạng  nên có một số đoạn có thể trùng với tài liệu của các tác giả 

khác, tôi đã cố gắng hướng dẫn rất chi tiết và tổng hợp một số tài liệu để các bạn có thể tiếp cận với 

phần mềm OrCAD một cách nhanh chóng.  

Các bạn đọc tham khảo và cho ý kiến để cuốn ebook này được hoàn thiện hơn.Xin chân thành cám ơn! 
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Link dowload: 

OrCAD 9.2 part1: http://www.mediafire.com/download.php?cpp7hztxpquc094 

OrCAD 9.2 part2: http://www.mediafire.com/download.php?s5h0e49kv6orr87 

Dùng phần mềm FFSJ để nối file: http://www.mediafire.com/download.php?blnyug2582ebiqb 

OrCAD 9.2 Protable : http://www.mediafire.com/download.php?o0z6sxoj672e11b 

Hoặc có thể liên hệ với tôi để lấy tài liệu, link dowload các phần mềm và ebook về 

điện tử 
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Chương 1: Cài đặt phần mềm OrCAD 9.2 

Để cài đặt OrCAD 9.2 bạn thực hiện các bước sau: 

- Cho đĩa CD cài đặt OrCAD vào máy hoặc có thể chạy trực tiếp trên ổ cứng: 

- Nhấp chuột phải vào file setup.exe , chọn Run as administrator như hình dưới 
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- Đợi vài giây chúng ta sẽ thấy hộp thoại xuất hiện như hình dưới và yêu cầu chúng ta nên tắt hết 

các chương trình diệt virut , nếu không thì trong quá trình cài đặt có thể xãy ra vài lỗi không 

mong muốn. Click vào OK để tiếp tục thực hiện công việc cài đặt. 

 

- Một hộp thoại mới hiện ra, chọn Next để tiếp tục: 
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- Chọn Yes trong hộp thoại Software License Agreement: 

 

- Chọn Next để tiếp tục trong hộp thoại tiếp theo: 

 

 

- ở hộp thoại tiếp theo yêu bạn nhập key codec là A B E F G H I J K ( Enter xuống dòng sau mỗi kí 

tự) chọn Next và nhập 17 chữ số 1 ở hộp thoại tiếp theo như hình dưới. Next để tiếp tục  
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- Nhập thông tin của bạn vào phần Name và Company.  Next để tiếp tục. Chọn Yes ở cửa sổ tiếp 

theo: 

 

- ở hộp thoại tiếp theo, có 2 tùy chọn: Typical nếu cài đặt các thành phần chung của OrCAD, 

Custom để setup các ứng dụng cần dùng. Chọn Next để tiếp tục 
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- Quá trình cài đặt bắt đầu, 

 

- Chọn Yes ở 2 hộp thoại tiếp theo 

 

- Và cuối cùng nhấn Finish để hoàn 

tất .  
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Quá trình cài đặt  phần mềm OrCAD 9.2 đã 

xong. Nhưng đừng vội mở phần mềm lên, nó 

vãn chưa chạy được, ta phải tiến hành Crack 

đã: 

- Tìm đến file PDXOrCAD.exe trong thư 

mục Crack của CD  

- Click chuột phải và chọn thẻ Properties, 

chuyển qua Tab Compatibility và chọn 

như hình dưới       ( nếu là win 7, còn 

win XP thì bỏ qua bước này ). Click 

Appy để hoàn xác nhận 

 

 

 

 

 

 

- Xuất hiện hộp thoại của phần mềm Crack PDXOrCAD  

- Chọn đường dẫn đến thư mục đã cài đặt OrCAD , ở đây tôi cài lên ổ C có đường dẫn là 

C:\Programm Files\Orcad\. Nhấp chọn Apply để thực hiện. Nếu xuất hiện dòng thông báo “ 

Fixed Patch – Success: All patches applied “ như hình thì quá trình cài Crack đã thành công, nếu 

xuất hiện thông báo lỗi thì hãy kiểm tra lại các bước trên xem đã đúng chưa. 
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Vậy là đã cài hoàn tất cài đặt phần mềm OrCAD 9.2 ( Lưu ý: Mỗi phiên bản có  một cách cài đặt và Crack 

khác nhau ). Khởi động chương trình OrCAD lên và khám phá. 
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Chương 2: Vẽ mạch nguyên lý bằng OrCAD Capture 

2.1 Tổng quan về OrCAD Capture 

OrCAD Capture là phần mềm vẽ mạch nguyên lý rất mạnh , với thư viện phong phú, thao tác đơn giản, 

dễ chỉnh sữa và tìm kiếm. 

Trong phần này tôi sẽ hướng dẫn khái quát để mọi người có thể tiếp cận và sử dụng phần mềm này. Từ 

khởi động , tạo một bản thiết kế, lấy linh kiện, thay đổi thông số linh kiện, đi dây, hoàn thành mạch 

nguyên lí đến việc tạo thư viện linh kiện cá nhân để tiện cho việc sử dụng về sau. 

2.2 Vẽ mạch nguyên lý bằng OrCAD Capture 

2.2.1 Khởi động OrCAD Capture 

Khởi động OrCAD với chương trình Capture( hoặc Capture Cis ): 

C1. Start -> AllPrograms-> Orcad Family Release 9.2 -> Capture ( Capture Cis ) 

C2. Click vào biểu tượng            trên màn hình Desktop 

Màn hình làm việc của Capture như sau: 
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2.2.2 Tạo một Project mới 

2.2.2.1 Tạo Project mới: 

Để tạo một project bạn có thể làm như sau: 

  Chọn menu File -> New -> Project. 

 

 Hoặc chọn nút lệnh Create document   

Hộp thoại New project hiện ra, nhập tên project trong phần Name ( Theo tôi mỗi 1 Project bạn nên lưu 

vào 1 thư mục riêng vì trong orcad 1 project có thể tạo ra rất nhiều file  )và đường dẫn đến vị trí lưu 

project trong phần Location 
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Click vào nút Browse để chọn đường dẫn cho project 

Nếu muốn tạo một thư mục con để chứa các file trong project của bạn, nhấp chuột vào Create Dir... 

 

 Nhập tên thư mục muốn tạo vào phần Name trong hộp thoại Create Directory. OK để xác nhận 

 

Màn hình của OrCAD Capture như sau: 
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2.2.2.2 Thiết lập kích thước và cài đặt ban đầu cho bản vẽ: 

Khi bắt đầu vẽ một Schematic chúng ta 

nên chọn menu Options -> Preference 

đặt các thuộc tính tùy chọn riêng chi 

người thiết kế về màu sắc hiển thị của 

Wire, Pin …tọa độ lưới vẽ trong trang 

thiết kế. Hộp thoại Preferences như 

sau: 

 

 -Chọn lớp Color/Print: hiện các gam 

màu để gán cho từng đối tượng trong 

trang sơ đồ mạch nguyên lí như: màu 

nền của background, pin linh kiện, tên 

linh kiện, bus, đường kết nối các thành 

phần, lưới vẽ, giá trị linh kiện, text, … 
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 -Chọn lớp Grid Display: Hiện/ 

không hiện ô lưới được thể 

hiện bằng những dấu chấm 

trong các trang thiết kế hoặc 

sửa đổi linh kiện. Mục đích 

của lưới là giúp chúng ta đặt 

linh kiện & sắp xếp so cho hợp 

lí & chính xác nhất 

 

 

 

 

 -Chọn lớp Pan and Zoom: 

hiện khung thoại chứa các  giá 

trị để thay đổi tỉ lệ thu phóng 

hay thu nhỏ các đối tượng 

trong trang thiết kế sơ đồ 

mạch. 
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 -Chọn lớp Select: hiển thị khung 

thoại liên quan đến việc lựa chọn 

các thành  phần trong trang sơ đồ 

nguyên lý. 

 

 

 

 

 

 

 

 

 

-Lớp Miscellaneous: chứa những 

thành phần hỗ trợ cho việc gán các 

thuộc  tính các đối tượng trong trang 

thiết  kế. Ngoài ra nó còn có chức 

năng rất quan trọng là tự động hiển 

thị số thứ tự của loại linh kiện được 

lấy ra  ( Automatic reference placed 

part ) & bắt tay chéo với Layout ( thẻ 

Intertool Communication ) rất hữu 

dụng trong việc sắp đặt các footprint 

linh kiện tùy thích của người thiết kế 

nhằm tránh trường hợp các linh kiện 

sắp xếp không theo ý muốn. Chức 

năng này chỉ có tác dụng khi mở cả 

Capture & Layout và xử lý cùng chung 

thiết kế. 
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Chọn menu Options > Design Templace… để gán các tham số mặc định cho 

bản thiết kế & các trang sơ đồ nguyên lí mới. Những giá trị được gán theo 

khung tham số này không ảnh hưởng đến những thiết kế của mạch điện cũ. Tại 

hộp thoại Design Template ta có thể tùy chỉnh thiển thị kiểu kí tự, size của các 

kí tự hiển thị tên, giá trị , … của linh kiện. Ngoài ra chúng ta có thể đặt têncủa 

thiết kế, size của thiết kế, đơn vị đo,… 

Chọn font hiển thị kiểu ký tự                                                                    thiết lập kích thước bản vẽ 
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2.2.2.3 Các đối tượng làm việc 

Thanh công cụ    

 Chọn đối tượng 

 Thư viện linh kiện 

 Chạy dây 

 Đặt nhãn đường mạch 

 Vẽ đường nối bus 

 Đặt điểm nối 

 Nối với đường bus 

 Nguồn 

 Mass 

 Điểm không nối 

2.2.3 Các phím tắt và từ khóa trong OrCAD Capture 

2.2.3.1 Phím tắt:  

Việc sử dụng các phím tắt sẽ giúp cho thao tác của chúng ta được nhanh hơn, và trong tài liệu này tôi 

chủ yếu hướng dẫn bằng các phím tắt 

Phím Chức năng Phím Chức năng 

R Xoay linh kiện W Nối các đương mạch 

I Phóng to màn hình O Thu nhỏ màn hình 

P Lấy linh kiện N Đánh nhãn 

J Tạo điểm nối B Vẽ đường bus 

T Thêm văn bản cho bản vẽ X Đánh dấu chân linh kiện ko sử dụng 

F Lấy các khối nguồn G Lấy các khối mass, nối đất 

Y Vẽ khối chữ nhật ESC Thoát chế độ đang chọn 
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2.2.3.2 Từ khóa tìm kiếm nhanh linh kiện 

Để thao tác được nhanh và lấy linh kiện chính xác thì bạn phải nhớ tên của các linh kiện,  ở đây tôi chỉ 

nêu một số từ khóa được sử dụng nhiều 

Kí hiệu Tên gọi Kí hiệu Tên gọi Kí hiệu Tên gọi 

R Điện trở RESISTOR VAR Biến trở CAP Tụ điện 

CAP NP Tụ không phân cực RELAY Rơ le LED Đèn led 

FUSE Cầu chì DIODE  Đi ốt DIODE ZENER Đi ốt ổn áp 

NPN Transistor ngược PNP Transistor thuận CRYSTAL Thạch anh 

BRIDGE Cầu diode SW Nút nhấn HEADR Chân cắm 

Khi làm việc với OrCAD các bạn chú ý là phải tắt các trình gõ tiếng việt đi thì mới sử dụng được các phím 

tắt , và tránh lỗi khi sử dụng các phím tắt, đơn giản là phần mềm nó không biết tiếng Việt.  

2.2.4 Vẽ sơ đồ nguyên lý 

Muốn vẽ được mạch nguyên lý thì các bạn phải có sơ đồ nguyên l{ đó ở 1 tờ giấy hay ở trong đầu bạn 

rồi. Bạn phải biết là sử dụng những linh kiện nào. 

2.2.4.1 Tìm kiếm và chọn linh kiện 

 Để lấy linh kiện ra bạn nhấn phím P ( hoặc Shift + P hoặc chọn Place Part ). 1 cửa sổ hiện ra như sau : 
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Ở khung Part cho phép chúng ta gọi ra các linh kiện, vậy linh kiện được lấy ở đâu? linh kiện được lấy ở 

Libraries. Nhưng chúng ta đang thấy Libraries trống trơn thế kia thì lấy làm sao được linh kiện? Vậy ta 

phải Add library sẽ hiện ra 1 cửa sổ như sau : 

Theo tôi thì nên Add tất cả các thư viện vào. Vì mỗi 1 thư viện chứa các linh kiện khác nhau mà ta không 

thể nhớ được linh kiện nào nằm trong thư viện nào. Thế là Add thư viện xong 

mailto:hanguyen92205@gmail.com


Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 2. OrCAD Capture 
 
 

  27 Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ BCVT Tp.HCM 

 Từ hộp thoại Libraries, các bạn chỉ chuột vào bất kz một trong các thư viện được add ( hoặc Ctrl + A để 

chọn tất cả thư viện ) thì danh sách các linh kiện trên cửa sổ Part List sẽ xuất hiện 

 Bạn đánh tên linh kiện vào khung Part để chọn linh kiện phù hợp với mạch nguyên lý 

Nhấp OK để chọn linh kiện, lúc đó cửa sổ này sẽ mất đi và linh kiện dính vào chuột của bạn 

Chọn vị trí thích hợp và nhấp chuột trái để đặt linh kiện 
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Nhấp chuột trái để tiếp tục đặt linh kiện vào các vị trí khác, nhấn ESC trên bàn phím để ngưng việc đặt 

linh kiện 

 Chọn và đặt đầy đủ linh kiện vào trang vẽ trước rồi tiến hành đi dây nối mạch 

Để nối dây bạn nhấp vào  bên thanh công cụ phải hoặc sử dụng phím W 

Nhấp chuột vào linh kiện và kéo đến vị trí khác nếu muốn di chuyên chúng 

Các thao tác Rotate ( R ) để xoay linh kiện, Vertical ( V ) để lật linh kiện theo chiều dọc hoặc Horizontal ( 

H ) để lật theo chiều ngang 

2.2.4.2 Vẽ mạch cụ thể 

Để các bạn dễ hiểu thí chúng ta sẽ đi vào vẽ mạch cụ thể, ở đây tôi chọn mạch điều chỉnh và ổn định tốc 

độ động cơ. Mach nguyên l{ như hình dưới: 

 
Nguyên lý hoạt động của mạch: Khi động cơ được nối đến J1 quay sẽ cho ra điện áp cảm ứng đặt vào chân số 

1 của Triac. Nếu động cở bị giảm tốc độ ( có thể do tải tăng lên) làm V1 giảm, D2 sẽ dẫn điện tạo dòng kích 

cho Triac. Dòng điện qua triac tăng lên sẽ làm tăng tốc độ động cơ tăng lên như cũ. Nếu động cơ bị tăng tốc 

độ ( có thể do tải giảm xuống ) làm V1 tăng, D2 bị phân cực ngược sẽ ngưng dẫn, giảm dòng điện cấp  cho 

động cơ, tốc độ động cơ giảm xuông như cũ. 
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 Các linh kiện trong mạch: 5 điện trở, 1 biến trở, 2 tụ không phân cực, 3 diode chỉnh lưu, 2 transistor 

ngược , 1 triac, 2 chân cắm, công tắc 3 cực 1 

 Enter để lấy R. sau đó R sẽ đi theo chuột của ta, nhấp chuột vào 5 vị trí để lấy 5 điện trở. Muốn thoát để 

lấy linh kiện khác thì ấn ESC,hoặc nhấp chuột vào biểu tượng  Select  trên thanh công cụ để kết thúc. 

Để chọn chân cắm cho linh kiện ta 

cũng làm tương tự, ở khung Part các 

bạn gõ CON2, sau đó nhấp OK để trở 

về màn hình làm việc.  

Bây giờ quay trở lại cửa sổ Place Part ( 

Shift + P hoặc P ). Lấy ra 1 con trở nào 

ở khung Part ta gõ vào R sẽ có hình 

ảnh như sau 
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Gõ RESISTOR VAR ở khung 

Part để lấy biến trở: 

 

 

 

 

 

 

 

 

 

 

 

 

Để lấy tụ điện không phân 

cực chọn CAP NP tại 

khung Part của thư viện 

sau đó OK để trở về màn 

hình làm việc 
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Tiếp theo, bạn chọn DIODE 

tại khung Part để lấy đi ốt, 

nhấp OK để trở về màn 

hình làm việc. Nhấp chuột 

trái vào 3 vị trí khác nhau 

để lấy 3 diode 

 

 

 

 

 

 

 

 

 

Chọn công tắc 3 chấu bằng 

cách gõ SW MAG-SPDT  

trong khung Part, sau đó 

nhấp OK để trở về màn 

hình làm việc. Tại trang vẽ 

nhấp chuột trái vào một vị 

trí bất kì để chọn công tắc 
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Để lấy Triac, tại khung Part 

của hộp thoại Place Part 

gõ TRIAC, sau đó nhấp OK 

và nhấp chuột trái vào vị 

trí bâts kì để chọn Triac 

 

 

 

 

 

 

 

 

 

Chọn cuộn dây bằng cách 

tại khung Part gõ 

INDUCTOR FERITE. OK để 

trở về màn hình làm việc 
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Tiếp theo chọn transistor 

NPN bằng cách gõ NPN 

vào khung Part. OK 

 

 

 

 

 

 

 

 

 

 

 

Cuối cùng, chọn chân 

Mass bằng cách nhấp vào 

biểu tượng Place Ground 

 bên thanh công cụ. Tại 

khung Libraries chon 

SOURCE, tại khung Symbol 

chọn 0, sau đó nhấp OK để 

trở về màn hình làm việc 
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Kết thúc việc lấy linh kiện,  ta có hình sau : 

 

 

2.2.4.3 Sắp xếp linh kiện 
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Các linh kiện vẫn nằm ngổn ngang thế, để có thể xoay được các linh kiện dọc, ngang, quay ngược xuôi 

các bạn chọn vào linh kiện cần xoay rồi ấn phím R, hoặc phím H, hoặc V( có thể chọn vào linh kiện kích 

phải chuột chọn Rotate = R, Mirror Horizontally = H, Mirror Vertically = V )… và sắp xếp linh kiện sao 

cho gọn để chuẩn bị nối dây. 

 

Để nối dây các bạn ấn phím W ( Place Wire ), con trỏ chuột sẽ thành dấu cộng và chúng ta bắt đầu nối 

dây. Xong ta được hình sau: 
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Muốn thay đổi giá trị cho linh kiện, hãy nhấp đúp chuột 

vào linh kiện, khi đó hộp thoại Display Properties xuất 

hiện. Tại khung Value của hộp thoại nhập vào giá trị của 

linh kiện muốn thay đổi, sau đó nhấn OK để hoàn tất thay 

đổi. 
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Đây là mạch hoàn chỉnh 

 

2.2.5 Kiểm tra lỗi sơ đồ nguyên lý 

Nhấp vào biểu tượng minimize trên góc phải hoặc biểu tượng  , xuất hiện màn hình như sau. Chọn 

page 1  
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Nhấp vào biểu tượng design rules 

check  

 Hộp thoại Design Rules Check xuất 

hiện, check vào Scope, Action & 

Report như hình bên và nhấp Ok để 

kiểm tra. 

Nếu có thông báo lỗi bạn hãy kiểm 

tra vị trí có khoanh tròn nhỏ màu 

xanh và tiến hành sửa lỗi rồi tiếp 

tục. 
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2.2.6 Tạo file netlist 

Sau khi kiểm tra không thấy lỗi , chúng ta tiến hành tạo file .mnl để chuyển 

sang Layout , chọn  trên thanh công cụ, hoặc chọn Tool=> Create 

Netlist  

 

 

 

 

Cửa sổ Create Netlist xuất hiện, chọn Layout, trong thẻ Options chọn User Properties are in inchers để 

tự chọn chân linh kiện footprint, Browse để duyệt đến nơi chứa file, nhấp chọn OK  

 

Chon OK trong hộp thoại xuất hiện tiếp theo để hoàn tất quá trình tạo file netlist 
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Vậy là đã hoàn tất quá trình vẽ mạch bằng Capture, bạn hãy dùng file .MNL vừa tạo để vẽ mạch in bằng 

OrCAD Layout Plus 

2.3 Tạo thư viện linh kiện mới trong OrCAD Capture 

2.3.1 Giới thiệu  

Việc tạo ra linh kiện mới trrong Capture rất quan trọng, các linh kiện điện tử đều được sản xuất theo 

một số tiêu chuẩn nhất định. Trong Layout thì một số chân linh kiện nếu không biết thì có thể tìm một 

linh kiện khác có chân tương tự, còn trong Capture thì công việc đó không thể thực hiện được. Hơn nữa 

việc tạo ra một thư viện mới của riêng bạn sẽ giúp bạn quản l{, cũng như thao tác nhanh hơn trong việc 

tìm kiếm linh kiện 

2.3.2 Các bước tạo linh kiện mới 

Một project bao gồm việc tạo ra linh kiện mới , tạo ra bản vẽ nguyên lý hoặc xuất ra mạch in,...Khi đó 

việc tạo ra linh kiện mới là việc làm để phục vụ cho schematic nào đó. 

Để tạo thêm linh kiện mới, các bạn phải nhận diện được linh kiên đó là gì, hoạt động như thế nào. Phải 

tra datasheet của linh kiện đó. Sau khi đã biết rõ về linh kiện, hãy hình dung trong đầu sơ đồ bố trí các 

chân linh kiện sao cho việc vẽ mạch nguyên lí được dễ dàng và đẹp nhất. 

 Tiếp theo là tạo ra một thư viện linh kiện để chứa linh kiện mà các bạn sẽ tạo ra. Vì đặc tính các đề tài là 

khác nhau và những người làm việc với mạch điện tử cũng khác nhau nên việc đặt tên cũng có những 

đạc thù khác nhau. Cuối cùng là việc tạo ra linh kiện bạn, đặt vào các thư viện phù hợp. Cụ thể tôi sẽ 

hướng dẫn các bạn tạo ra con MAX232. 

2.3.2.1 Tìm datasheet 

Việc đầu tiên là phải tra cứu datasheet của con MAX232. Để tra datasheet bạn có thể search trên mạng 

http://google.com hoặc tìm trực tiếp từ các trang web về datasheet: 

www.alldatasheet.com  

 www.datasheetcatalog.com 
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Đây là hình ảnh của con MAX232 trong datasheet 

 

 

 

 

2.3.2.2 Tiến hành tạo linh kiện 

Trong màn hình làm việc của Capture.  

Chọn  File > New > Library  

 

T rong cửa sổ quản lí, nhấp chuột phải 

vào library.olb tại thư mục Library, chọn 

New Part để tạo linh kiện mới 

 

 

 

 

Nhập tên linh kiện vào 

khung Name ( tên này sẽ 

được hiển thị khi bạn chọn 

linh kiện). Chọn kiểu linh 

kiện trong ô Part 

Reference Prefix. 

Ở đây chọn là U 

Nhấp OK để vào trang 

thiết kế 
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Cửa sổ làm việc như sau: 

 

Trước hết chúng ta cần tạo ra nhóm chân, sau đó sửa chữa thông số, những nhóm chân có cùng chức 

năng ta ta thiết kế chung.  

Chọn Place Pin Array   trên 

thanh công cụ để tạo nhóm chân cho 

linh kiện 

Ô Starting Name ( tên chân) :         1 

Starting Number ( Chân bắt đầu):  1 

Number of Pins ( số chân được tạo ra 

trong cùng nhóm chân):                   8  

Increment ( số đơn vị tăng lên) :    1 

OrCAD hỗ trợ việc tạo ra các nhóm 

chân bằng cách tự động tăng thứ tự 

tên chân Starting Name, Starting 

Number lên Incrment đơn vị, nếu như 

chân đó tận cùng là 1 số. 
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Khi nhấn OK, con chuột sẽ tạo thành 1 dãy 8 chân linh kiện. Trên khối U 

vuông, các bạn đặt nó cạnh nào, nó sẽ nằm ở cạnh đó.Nhấp chuột để hoàn 

tất.  

 

 

T iếp tục tạo các chân còn lại. Chọn Place pin array   

Ô Starting Name : 16  

Starting Number: 16 

Number of Pins : 8 

Increment: -1 

OK và chọn vị trí đặt chân 

 

Nhấp đúp chuột vào chân linh kiện để sửa đổi các thông số: tên, 

số chân linh kiện  

 

 

 

Tiếp tục cho các chân còn lại. Nhấp chuột trái và kéo giữ chuột để sắp xếp 

lại vị trí các chân linh kiện cho hợp lí & thẩm mỹ. 

 

2.3.3 Vẽ đường bao và lưu linh kiện 

Chọn  Place rectangle  trên thanh công cụ để tạo đường 

bao, vẽ hình vuông vừa khít trên hình.Chọn Place Text để nhập tên 

cho linh kiện.Như vậy là đã làm xong 1 linh kiện mới, nhấn Save để 

lưu lại linh kiện.  

2.4 Chỉnh sửa linh kiện 

2.4.1 Đặt vấn đề 
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Khi lấy linh kiện trong thư viện, có một vấn đề là đa số với con IC thì bị ẩn chân VCC và GND, nhưng các 

bạn yên tâm khi xuất ra mạch in chân VCC mặc nhiên nối với Power và chân GND thì nối đất. Tôi sẽ chỉ 

cho cách làm cho nó hiện lên 

2.4.2 Tiến hành chỉnh sửa 

Ở đây tôi chọn con IC định thời 555 

Bạn nhấp phải chuột vào linh kiện, chọn Edit Part  

 

 

 

 

Xuất hiện cửa sổ làm việc  mới giúp bạn chỉnh sửa các thông số của linh kiện: 

Phần 2 dấu cộng trong vòng tròn màu đỏ là 2 chân VCC và GND, bạn nhấp đúp chuột vào nó để chỉnh 

kiểu chân 
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Hình dạng chân của nó trong cửa sổ Shape, trong cửa sổ này chân được lựa chọn là zero length chính vì 

vậy mà bạn không nhìn thấy nó, bạn có thể chọn Line hoặc Short để hiển thị chân. Tick vào Pin Visible 

để hiển thị tên của chân linh kiện 

Tương tự như trên để hiển thị chân GND. Bố trí lại sơ đồ chân cho 

hợp lý và thẩm mỹ, Sau khi chỉnh sửa ta được hình bên 

 

 

 

 

Trong cửa sổ này bạn cũng có thể thực hiện chỉnh sửa, thêm bớt chân, thay đổi kích thước hình dáng 

của linh kiện. 

2.4.3 Lưu linh kiện vừa chỉnh sửa 

Nhấp chuột vào nút Close  trong cửa sổ làm việc hoặc nhấn Ctrl + W, xuất hiện hộp thoại 

 

 

 

Chọn Update 

Current để lưu 

thay đổi, Update All để thay đổi tất cả linh kiện đó có trong Project, Discard để hủy bỏ thay đổi, Cancel 

để quay lại hủy bỏ thao tác, Help để được trợ giúp. 
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Vậy là đã hoàn tất cơ bản phần Capture, tiếp theo ta chuyển sang phần Layout để thiết kế mạch in. 

( luôn Ctrl + S để lưu bản project , phòng  sự cố xảy ra ngoài ý muốn ) 
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Chương 3: Vẽ mạch in với OrCAD Layout 

3.1 Tổng quan về phần mêm vẽ mạch in OrCAD Layout 

Để thi công board mạch thực tế cần phải xuất mạch nguyên lý trong Capture sang file mạch in được hỗ 

trợ bởi Layout. Phần này sẽ hướng dẫn các bạn xuất file .mnl trong mạch nguyên lý sang Layout để vẽ 

mạch in hoàn chỉnh, cách chọn chân linh kiện footprint, tạo thư viện chân linh kiện mới,... 

3.2 Vẽ mạch in với OrCAD Layout 

3.2.1 Khởi động OrCAD Layout 

Khởi động OrCAD với chương trình Layout Plus 

- Start -> AllPrograms-> Orcad Family Release 9.2 -> Layout 

- Click vào biểu tượng              trên màn hình Desktop 

Màn hình làm việc của Layout Plus như sau 
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3.2.2 Một số lệnh cơ bản 

3.2.2.1 File 

Chứa các lệnh liên quan đến việc tạo mới, mở, nhập và xuất ra các tập tin đối tượng vòa Layout hay sang 

các thành phần khác ( để sử dụng trong một số phần mềm thiết kế mạch khác như Protel, PCAD PCB, ...) 

3.2.2.1.1 Open 

Liệt kê tất cả các tập tin .MAX đang nằm trong thư mục hiện hành. 

3.2.2.1.2 Import 

Cho phép mở hay nhận một file đã được tạo từ các phần mềm khác như Protel PCB, CadStar PCB,... 

3.2.2.1.3 Export 

Cho phép xuất file .MAX đã được tạo từ OrCAD Layout sang các phần mềm thiết kế mạch in khác như 

Protel PCB, CadStar PCB,... 

3.2.2.2 Tools 

3.2.2.2.1 Library Manager 

Cho phép bạn chỉnh sữa hay tạo mới một footprint của linh kiện nào đó. Từ đây bạn có thể tạo hay sưu 

tập một thư viện footprint linh kiện mà bạn hay sử dụng cho các thiết kế về sau. 

3.2.2.2.2 OrCAD Capture 

Cho phép mở chương trình thiết kế mạch nguyên lý OrCAD Capture từ chương trình vẽ board mạch 

OrCAD Layout 

Ngoài ra trong Tools còn các chức năng khác như SmartRout cho phép bạn vẽ mạch thông minh, Edit 

App Settings, Reload App Settings,... 

3.2.3 Tạo bản thiết kế mới  

Để tạo một bản thiết kế mới, vào menu File -> New hoặc từ biểu tượng  trên thanh công cụ. Xuất 

hiện hộp thoại Load Template File, ta nhập vào file Template theo đường dẫn mặc định: 

C:\Program Files\Orcad\Layout_Plus\Data 

File template là file định dạng một số thông số mặc định cho board mạch, như số lớp board mạch, 

khoảng cách đi dây, kích thước đường mạch, quy định thiết kế,... được sử dụng xuyên suốt trong quá 

trình vữ mạch với Layout. Nếu là một board bình thường thì bạn chọn file default.tch ( hoặc 

jump6238.tch sẽ giúp quá trình chạy mạch hiệu quả hơn , các jumper sẽ không cắt ngang IC,…). Còn nếu 
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bạn muốn thiết kế board mạch riêng theo hình dạng cụ thể, như Sound Card, Lan card,... thì load các file 

template khác. Nhấn Open để thực hiện load file .TCH 

 

Xuất hiện hộp thoại Load Netlist Source yêu cầu bạn chọn file netlist có đuôi .MNL đã được tạo trong 

OrCAD Capture. Nhấp Open để chọn mở file Netlist 
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Tại hộp thoại Save File As bạn nhập vào đường dẫn và tên file mà bạn muốn lưu  thiết kế của mình. Mặc 

định Layout Plus sẽ đặt tên file mặc định trùng với file netlist và lưu trong thư mục chứa project đó. 

 

Nhấp Save để tiến hành lưu. 
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Nếu các linh kiện trong mạch thiết kế là các linh kiện mới và chưa từng có liên kết đến thư viện footprint 

của Layout Plus lần nào thì sẽ xuất hiện hộp thoại yêu cầu bạn phải liên kết đến footprint. Đây là bước 

khó khăn đòi hỏi bạn phải cẩn thận, nếu như chọn sai chân thì mạch coi như bỏ đi, ttos nhất bạn hãy 

xem kỹ hình ảnh thực tế của linh kiện để việc chọn hình dạng và kích thước của footprint được chính 

xác. Kinh nghiệm cho thấy sẽ tốt hơn nếu bạn tực hiện việc gắn footprint cho tất cả các linh kiện trong 

suốt quá trinh vẽ mạch bằng Capture. 

3.2.3.1 Liên kết Footprint 

Để làm tốt phần này bạn phải thường xuyên làm mạch, có kinh nghiệm thì việc tìm kiếm các footprint 

được nhanh hơn. 

3.2.3.1.1 Một số footprint thông dụng 

- Thư viện TO : TO92 ( transistor: C828, C1815, C535,...), TO202 ( Transistor: H1061, IC ổn áp họ 78xxx, 

79xxx,... ) 

- Thư viện DIP100T: /W.300 ( các IC cắm từ 14-20 chân ) /W.600 ( các IC cắm từ 24-40 chân ) 

- Thư viện TM_CAP_P là footprint của các loại tụ điện 

- Thư viện JUMPER là footprint của các loại điện trở, quang trở, biến trở,.. 

- Thư viện TM_DIODE là footprint của các loại diode hay led 

3.2.3.1.2 Liên kết đến footprint 

Quay lại màn hình làm việc của Layout sẽ xuất hiện hộp thoại  sau: 

 

Trong hộp thoại Link Footprint to Component có thông báo là không tìm thấy chân của D1 có tên là 

DIODE. Vì thế nên tìm chân cho linh kiện này bằng cách nhấp chuột vào liên kết Link existing fooprint to 

component... 
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Hộp thoại Footprint for DIODE xuất hiện , nếu là lần đầu tiên sử dụng thì bạn phải add thư viện vào 

bằng cách nhấp chuột trái vào nút Add... 

 

Bạn chọn đường dẫn đến thư viện Layout mặc định là C:\Program Files\Orcad\Layout_Plus\Library. 

Bạn nên add tất cả vào để tiện cho quá trình sử dụng 
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Tại khung Libraries nhấp chọn mục JUMPER. Tại khung Footprints nhấp chọn mục JUMPER200 ( khoảng 

cách giữa 2 chân là 200 mils = 5 mm ) để chọn chân diode. OK để thực hiện 

Tiếp theo trong hộp thoại Link Footprint to Component có thông báo là không thể tìm thấy chân của 

chân cắm J1 có tên CON2. Nhấp chuột vào Link existing fooprint to component... 

 

Trong hộp thoại Footprint for CON2, tại khung Libraries chọn JUMPER, tại khung Footprints chọn 

JUMPER100. Xong nhấp chọn OK. 

Trong hộp thoại Link Footprint to Component có thông báo là không thể tìm thấy chân linh kiện Q3 có 

tên T2801  
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Nhấp vào Link existing fooprint to component...Trong hộp thoại Footprint for T2801, tại khung 

Libraries chọn TO, khung Footprints chọn TO202AB để chọn chân cho Triac 

Tiếp tục chọn liên kết chân linh kiện cho các chân còn lại ( transistor Q1, Q2 tương ướng là TO - > TO126, 

cuộn dây L1 là thư viện JUMPER chọn JUMPER100, công tắc 3 chấu và biến trở chọn lần lượt là TO-> 

TO202AB và TO-> T126, tụ điện chọn JUMPER - > JUMPER100,...) cho đến khi nào không còn xuất hiện 

hộp thoại Link Footprint to Component nữa. Khi hoàn thành liên kết đến các footprint với linh kiện, 

OrCAD Layout tự động load các footprint như hình vẽ: 

 

3.2.4  Footprint trên board mạch 

Khi các fooprint được load, nếu không đúng với yêu cầu thiết kế thì phải chỉnh sửa hoặc tạo mới chân 

linh kiện cho phù hợp 

3.2.4.1 Chỉnh sửa fooprint 

Chọn linh kiện cần thay đổi trên board mạch vừa load, sau đó nhấp chuột phải  chọn Properties hoặc 

nhấp đôi chuột vào linh kiện 

Hộp thoại Edit Component xuất hiện, ở đây bạn có thể sửa lại tên và giá trị linh kiện, Nhấp chuột vào 

Footprint... để thay đổi footprint 
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Từ hộp thoại Select Footprint ta có thể lựa chọn các footprint thích hợp. Tuy nhiên nếu không tìm thấy 

footprint phù hợp thì ta phải tạo mới fooprint cho phù giợp với linh kiện 
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3.2.4.2 Tạo mới chân linh kiện 

Ta có thể tạo mới chân linh kiện bằng cách trong chương trình Layout Plus, vào menu Tools -> Library 

menager 

  

 

 

 

 

 

 

 

Để tạo một footprint mới hoàn toàn bạn bấm Create New Footprint … 

Ví dụ:   

Tạo footprint cho một pushbutton (Panasonic part EVQ-PAG04M) bạn cần một số thông tin về kích 

thước của nó: 

 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 3. OrCAD Layout 
 

Nguyễn Ngọc Hà. Email: hanguyen92202@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCm  57 

Ở hộp thoại Create New Footprint   

Nhập tên linh kiện mới ở mục Name of 
footprint, ví dụ là PB 
Bấm chọn English. Mặc dù kích cỡ các bộ 
phận của linh kiện được cho ở hệ mét nhưng 
hầu hết kích thước chế tạo PCB vẫn bằng đơn 
vị inches ( hay mils = 1/1000 inch).  
 

 

 
Để dùng theo hệ mét bạn phải thay đổi systems settings. (vào Options -> System  Settings) xuất hiện 
hộp thoại bên. 
Nhấp OK. Bây giờ bạn đang làm việc theo hệ mét. 

 

Switch có tất cả 4 chân nhưng ta chỉ cần định dạng cho 1 padstack vì các chân dều có đặc điểm giống 

nhau. 

Đầu tiên vào View ->  Spreadsheet ->Padstacks. Ta thấy xuất hiện hộp thoại padstacks, ta double click 
vào padstack có tên T1 sẽ xuất hiện hộp thoại Edit Padstack cho tất cả các lớp của T1. 
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Bạn thay đổi tên của padstack này, thường thì 

đặt tên theo tên footprint. Điều này làm cho 

việc tìm kiếm nó dễ dàng hơn trong Layout khi 

có nhiều padstack. Tiếp đó nhấp chọn 

Undefined trong mục Pad Shape 

Nhấp OK. Xuất hiện hộp thoại padstacks. Bạn 
thấy padstack tên PB với tất cả các lớp của nó 
không được định dạng      
 
 
 
 
 
 
 
 
 
 
 
 
 
                    

 

 

Dựa vào Datasheet bạn định dạng cho các lớp của padstack PB. Nếu chọn nhiều lớp cùng một lúc thì 

nhấn chọn tên các lớp đồng thời giữ phím Ctrl. Bạn chỉ cần định dạng cho những lớp cần thiết . 

Đầu tiên bạn cần định dạng kích thước cho chân lỗ khoan, theo datasheet đường kính chân lỗ khoan là 1 
mm. 
Ta chọn 2 lớp DRLDWG, DRILL.  
Click phải chuột chọn Properties , xuất hiện hộp thoại Edit Padstack Layer , nhấp chọn Round, sau đó 
nhập giá trị 1(=40 mils) vào Height và Width. 
Nhấp OK 
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Bạn thấy trong hộp thoại padstacks lớp DRLDWG, DRILL đã được định dạng: 

 

Tương tự bạn định dạng cho các lớp TOP, BOTTOM, INNER. Thường thì kích thước của vòng xuyến bao 

quanh lỗ chân khoan lớn hơn lỗ khoan khoảng 20 mils(=0.5 mm). Do đó nhập giá trị 1.5mm vào Height 

và Width. 

Vì lớp giữa của mạch là miếng đồng dành cho power và ground, để tránh hiện tượng ngắn mạch người 

ta thường tạo ra xung quanh các lỗ khoan một khoảng trống, lớn hơn kích thước lỗ khoan là 35 

mils(=1.75 mm). Bạn nhập giá trị 2 mm vào Height và Width và chọn pad dạng round cho lớp PLANE. 

Cuối cùng bạn cần định dạng cho mặt để hàn chân linh kiện, thường thì nó lớn hơn vòng xuyến bao 

quanh chân lỗ khoan khoảng 5 mils(=0.125 mm). Do đó bạn chọn pad hình round và nhập giá trị 

1.625mm vào Height và Width cho lớp SMTOP and SMBOT. 
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Sau khi định dạng xong cho các lớp của padstack này, ta sẽ lưu tên của footprint mới tạo vào thư viện, ta 

nên tạo thư viện mới để dễ dàng tìm kiếm sau này.  

Bằng cách click Save As trong hộp thoại Library manager.  
Điền tên footprint mới tạo, sau đó click vào Create New Library để tạo thư viện mới.  

 

Nhấp OK thì footprint mới tạo sẽ được lưu vào thư viện. 
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Sau đó chọn Text tool  để xóa bớt 

các chữ không cần thiết đi, chỉ để lại 

&Comp và &Value. Nhấp vào text cần 

xóa và bấm phím Delete (trên bàn 

phím).  

Thêm các chân linh kiện vào bằng cách 

chọn công cụ Pin Tool .  

Click chuột phải vào nền đen, chọn 

New…   

Đặt chân mới ở vị trí thích hợp  
 

Chọn thuộc tính cho 2 text còn lại bằng kéo chuột để bôi nó, xong click chuột phải, chọn Properties 

(phím tắt Ctrl+E). 

Chọn Layer là SSTOP. 
Chọn OK. 
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Sau đó bạn sắp xếp lại vị trí cho các chân, bạn luôn luôn đặt vị trí của pad1 tại  

(x,y) = (0, 0) > double click vào pad1 xuất hiện hộp thoại EDIT PAD. 

 

Bạn dựa vào Datasheet biết khoảng cách giữa các chân để xác định vị trí cho các chân còn lại. Pad2 = (0, 
6.5) 
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Các chân khác tương tự: Pad4 = (4.5, 0), Pad3 = (6.5, 4.5)  

 
 
Bạn có thể dùng các công cụ đo đạc như: Dimension, Measurement trong menu Tool để có thể tạo 
khoảng cách chính xác giữa các chân. 
Ngoài ra bạn còn có thể vẽ thêm các đường bao (Obstacle) cho linh kiện, đây là đường ranh giới giữa các 
footprint để khi sắp xếp chúng không bị chồng chéo nhau.  

Để vẽ đường bao bạn click vào biểu tượng Obstacle Tool  , sau đó click phải chuột chọn New, giữ 
chuột trái đồng thời kéo đến các góc chân pad, đường bao bao quanh các chân pad. 
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Đầu tiên bạn đặt tên cho đường bao, sau đó chọn  Place Outline tại ô Obstacle Type. Độ dày width tùy 
ý. 

 

Thường bạn chọn đường bao này nằm ở lớp Global Layer, tức thuộc tính Obstacle Layer là Global Layer.   

Cuối cùng click OK để lưu lại các định dạng cho footprint mới tạo. 

Bạn đã hoàn thành việc tạo 1 footprint mới không có sẵn trong thư viện của layout. 

Để nhanh hơn bạn có thể lướt qua thư viện của layout tìm những footprint tương tự footprint mà bạn 

cần tạo để sửa chữa cho phù hợp với thực tế rồi Save As nó lại, lưu lại trong thư viện mới mà bạn tạo 

cho dễ tìm kiếm. 

3.2.4.3 Những chú ý khi tạo mới chân linh kiện 

Khi thiết kế footprint, ngoài việc bạn cần biết chính xác kích thước thực giữa các chân linh kiện để thiết 

kế kế đúng, còn phải biết kích thước của cả linh kiện để có thể bố trí khoảng cách giữa các linh kiện cho 

hợp lý. 

Một số kinh nghiệm chọn kích thước cho chân linh kiện: 
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- Với các linh kiện thường như điện trở, tụ, diode … bạn chọn chân hình tròn (Round), đường kính 

là 1.8 đến 2.1, tùy loại linh kiện 

- Chân 1 của IC hay các linh kiện có cực tính như tụ hoặc diode bạn nên chọn kiểu chân là hình 

vuông hoặc hình chữ nhật 

- Với IC ta nên chọn chân hình Oval (với các chân 2 trở lên) và hình chữ nhật (đối với chân 1). Kích 
thước thường là 1.7mm Width và 2.2 mm Height. 

- Với các chân linh kiện to như chân của các JACK cắm, chân của đế IC có cần thì nên chọn bề 
Width(bề ngang) to ra một tí, cỡ 1.8mm. 

Thực tế việc tạo ra linh kiện trong Capture quan trọng hơn rất nhiều lần so 

với việc tạo ra linh kiện trong Layout (hay Layout Plus). bạn chỉ cần sử dụng các chân layout có định 

dạng giống vậy đểsử dụng, không nhất thiết phải tạo ra các định dạng chân cho từng linh kiện riêng biệt. 

3.2.5 Một số thao tác cần thiết trước khi vẽ Layout 

Đầu tiên, bạn sẽ tắt DRC (Design Rule Check), bạn sẽ cần dùng chúng sau, nhưng không phải bây giờ. 
Sau khi tắt, khung chữ nhật nét đứt sẽ biến mất. 
Những ký hiệu xuất hiện bên cạnh các linh kiện có thể không cần thiết nhưng chúng sẽ làm cho màn 
hình của chúng ta rối hơn. Có 2 cách để xóa chúng đi: 

- Chọn Text Tool  trên thanh công cụ, click chuột vào đoạn ký hiệu mà bạn muốn xóa đi, sau 
đó click chuột phải và chọn delete. 

- Hoặc nếu bạn muốn xóa hoàn toàn các ký hiệu đi kèm, bạn làm như sau: Chọn lớp 23 AST như 
hình vẽ, sau đó tắt nó đi.(sử dụng phím “-”) 

3.2.6 Thiết lập môi trường thiết kế 
3.2.6.1 Thiết lập đơn vị đo và hiển 

thị. Đây cũng là đơn vị thể hiện độ 

rộng của đường mạch in trong board 

mạch. Mục đích của vấn đề này là giúp 

cho người thiết kế quản lý được kích 

thước của các nets trong board mạch 

cũng như kích thước của board 

outline. Cách làm như sau: Vào 

Options -> System settings. Bạn sẽ 

thấy hộp thoại sau xuất hiện: Ở đây 

bạn nên chọn đơn vị là 

Millimeters(mm). Ngoài ra ta còn có 

thể thiết lập lưới vẽ, đặt lưới nếu cần 

thiết ở khung Grids. 
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3.2.6.2. Đo kích thước board mạch 

Vào Tool -> Dimension -> Select Tool.  

Sau đó đo độ dài và độ rộng của đường bao. Mục đích của cách làm này là cho người thiết kế biết được 

board mạch mình thiết kế có kích thước thật bao nhiêu, để từ đó có những điều chỉnh hợp lý trong việc 

sắp xếp các linh kiện trong đường bao cho phù hợp với board mạch in mà  mình đang có. 

 

3.2.6.3 Layer Stack 

Để định nghĩa Layer Stack, bạn chọn View Spreedsheet từ Toolbar 
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Nhấp Layers để chọn lớp vẽ, ở đây bạn chọn lớp BOTTOM, click chuột phải chọn Properties. 

 

Chọn như sau và OK 

 

3.2.6.4. Thiết lập khoảng cách giữa các đường mạch 

Để thiết lập những luật về khoảng cách cho pads, tracks và vias. Bạn chọn View Spreedsheet từ Toolbar. 

Chọn Strategy -> Route Spacing. 
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Từ menu pop up chọn Properties: 

 

Xuất hiện hộp thoại: Edit Spacing 

 

Ở đây bạn có thể điều chỉnh các thông số cho phù 

hợp. Cần chú ý đơn vị đo mà bạn đã thiết lập ở trên. 

Chọn OK. 

 

 

 

 

 

 

 

3.2.6.5 Thiết lập độ rộng đường mạch in 

Bạn làm điều này để điều chỉnh độ rộng của các nets trong mạch khác nhau tùy theo chức năng của 

chúng. Thường thì: các đường nguồn, mass phải lớn hơn các nguồn tín hiệu, hay các đường ứng với 

mạch công suất thì bề rộng cũng phải lớn hơn bình thường…Muốn điều chỉnh các thông số này bạn có 

thể làm như sau: Vào View Spreedsheet → Nets. Bôi đen tất cả, chọn Properties 
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Hộp thoại Edit Net cho phép ta chỉnh các thông số của Nets 

 

Min Width, Conn Width, Max Width là độ rộng của nets mạch in. Không nên để 3 giá trị này bằng nhau, 

vì khi đi mạch máy sẽ tự động điều chỉnh độ rộng của nets. Khi ít đất thì nó chọn Min, khi nhiều sẽ chọn 

Max, như vậy sẽ linh hoạt hơn. 

3.2.6.6 Vẽ đường bao 

là đường bao ngoài cho tất cả các linh kiện và các đường mạch trong mạch in. Để vẽ bạn tiến hành như 

sau: 

Click chuột vào Obstacle Tool, sau đó click vào một góc mà bạn muốn vẽ Outline, con chuột chuyển 
thành dấu cộng nhỏ, click phải, chọn Properties sẽ hiện ra hộp thoại sau: 
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Bạn chọn như hình vẽ. Sau đó chọn OK. 
Click vào 4 góc của khung mà bạn muốn vẽ, sau đó nhấn ESC. 

3.2.7. Sắp xếp  linh kiện lên board mạch 

Việc bố trí linh kiện lên board mạch là một trong những yếu tố quan trọng quyết định 

đến độ ổn định, dễ vẽ và thẩm mĩ,v.v…của board mạch.  

Bạn có thể sắp xếp linh kiện bằng tay hoặc sử dụng chức năng tự động sắp xếp của 

Layout Plus. 

3.2.7.1. Sắp xếp linh kiện bằng tay 

Nhấp chuột vào biểu tượng Component Tool trên thanh công cụ.Để di chuyển linh kiện nào ta nhấp 

chuột vào linh kiện đó, sau đó, khi nhả chuột ra và di chuyển thì linh kiện cũng sẽ di chuyển theo. Đến vị 

trí cần đặt linh kiện thì nhấp chuột một lần nữa, và linh kiện sẽ được cố đinh. 
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Sau khi sắp xếp một lúc ta được như sau: nhấp chuột vào Reconnect Mode  để ẩn /hiện dây nối 

 

 
3.2.7.2. Sắp xếp linh kiện tự động 

Đầu tiên bạn cần phải cố định một số linh kiện mà bạn muốn nó được đặt ở một vị trí xác định, tránh bị 

thay đổi vị trí trong quá trình auto. Di chuyển linh kiện đến vị trí xác định, nhấp chuột phải chọn Lock. 

Sau khi đã cố định được các linh kiện theo yêu cầu, chọn Auto  -> Place -> Board. 

3.2.8 Vẽ mạch 

Layout Plus hỗ trợ cả 2 chức năng vẽ tự động và vẽ bằng tay. Thông thường nên kết hợp cả 2 chức năng 

này, vì khi vẽ tự động đôi khi sẽ có những đường mạch rất phức tạp, lúc đó ta nên điều chỉnh lại bằng 

tay. 
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3.2.8.1. Vẽ tự động 

Vào Auto -> Auto Route -> Board, Layout Plus sẽ tự động vẽ mạch. 

3.2.8.2. Vẽ bằng tay 

Chọn Edit Segment Mode . Kích vào dây muốn vẽ, lúc đó dây sẽ gắn với con trỏ, rê 

chuột để tạo đường mạch, kích trái chuột để cố định đường mạch. 

Để đổi hướng đường đi của mạch: kích vào cuối đoạn dây, sau đó đổi theo hướng mà bạn muốn vẽ. 

Sau khi vẽ xong, nhấn ESC để kết thúc. 

Nhấp F5 để refresh bản mạch. 

Sau khi vẽ, bạn sẽ được như sau: 
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3.2.9. Hoàn thiện bản mạch 

Về cơ bản, chúng ta đã hoàn thành việc vẽ mạch in. Trong phần này bạn sẽ tiến hành một số thao tác 

cuối cùng trước khi xuất mạch in 

3.2.9.1. Chèn một đoạn text vào mạch in 

Chọn Text Tool từ thanh công cụ. Click phải vào màn hình chọn 

New. 

Hộp thoại Text Edit hiện ra, trong khung Text String gõ nội dung cần chèn. 

 Lưu ý: nếu bạn làm mạch in thủ công thì click chọn Mirrored để khi ủi không bị ngược. Chọn lớp hiển thị 

trong khung Layer ( thường thị chọnTOP và BOTTOM ), và kích thước chữ . chọn OK để hoàn tất 

 

Di chuyển đoạn text đến vị trí cần chèn, click chuột. 
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3.2.9.2. Phủ mass cho mạch in 

Mục đích của vấn đề này là để chống nhiễu cho mạch điện.  

Cách làm như sau: 

Chọn Obstacle Tool. Nhấp chuột vào khung mạch, con chuột co 
thành dấu cộng nhỏ thì click phải, chọn Property.  
Màn hình sẽ xuất hiện hộp thoại Edit Obstacle. 
 

 

- Trong khung Obstacle Type chọn: Copper Pour. 
- Trong khung Obstacle Layer chọn lớp cần phủ Copper Pour: có thể là TOP hay BOTTOM. 
- Trong khung Net Attachment thì chọn là GND hoặc POWER, tùy theo bạn muốn phủ theo GND 

hay POWER. Nếu không thì ta để dấu “ – “ 
- Nhấn OK. 
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Bản mạch hoàn chỉnh: 

 

Nếu vẽ mạch nhiều lớp thì trong lúc vẽ, nhấn phím Backspace và các phím số để hiển thị  một số lớp 

nhất định,1: TOP, 2: 

BOTTOM, ... 

3.2.10. In mạch Layout 

Để in mạch vừa vẽ, bạn 

thực hiện các bước sau: 

- Chọn Option -> 
Post Process 
Settings 

- Nhấp chuột phải 
vào lớp muốn in 
(vd: lớp 
BOTTOM), chọn 
Preview 
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- Vào menu File, chọn Print/Plot ( Ctrl + P ) 
- Chọn như hình dưới rồi nhấp OK 

 
 

Kết quả:  

 

Vậy là đã hoàn chỉnh 1 board PCB , tôi sẽ hướng dẫn các bạn làm mạch in thủ công tại nhà ở phần sau. 
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Chương 4: Mô phỏng bằng PSPICE 

4.1 Tổng quan về phần mêm mô phỏng Pspice  

4.1.1 Giới thiệu về Pspice 

Kỹ thuật điện là ngành khoa học nghiên cứu những ứng dụng của các hiện tượng điện, từ nhằm biến đổi 

năng lượng và tín hiệu, bao gồm việc thu hập , gia công, xử lý, truyền tải tín hiệu 

Để thuận tiện cho việc tính toán, thiết kế các thiết bị điện tử, người ta thường thay thế các mạch điện 

thực tế bằng các mô hình thay thế và các sơ đồ mạch điện tương đương. Việc phân tích các mạch điện 

nhằm dự đoán và kiểm tra khả năng làm việc của các thiết bị điện  tử hoặc nhằm đưa ra các sản phẩm 

phù hợp với yêu cầu đặt ra. 

Phương pháp thực tế để kiểm tra một mạch điện là xây dựng chúng. Tuy nhiên hiện nay, khi mà các 

thành phần của một mạch tích hợp có kích thước ngày càng nhỏ bé thì việc xây dựng các vi mạch này trở 

nên rất khó khăn, Bên cạnh đó, những tác động vật lý, âm thanh, ánh sáng,...không ảnh hưởng đến 

mạch điện thông thường nhưng lại gây nhiễu rất lớn đối với các vi mạch. Vì vậy, việc lắp ráp các vi mạch 

từ các thành phần trong phòng thí nghiệm đòi hỏi nhiều thời gian, công sức và tiền bạc 

Sự phát triển của công nghệ thông tin cho phép xây dựng các phần mềm mô phỏng và phân tích quá 

trình làm việc của mạch điện tử. Khi đó ta có thể xây dựng, thử nghiệm, khảo sát hoạt động của mạch 

ứng với các trường hợp cũng như việc thay đổi các thông số kỹ thuaaj cũng như khảo sát ảnh hưởng của 

chúng đến quá trình làm việc của mạch. Do đó tăng tính mềm dẻo và khả năng khảo sát nhiều trường 

hợp, tình huống khác nhau 

Vấn đề khó khăn khi sử dụng các phần mềm là tính chính xác của mô hình. Nếu các mô hình không có 

các đặc tính giống như các phần tử thực thì việc mô phỏng là vô nghĩa 

Spice ( Simulation Program with Integrated Circuit Emphasis ) là một chương trình tính toán mô phỏng 

và mô hình hóa các mạch điện tử tương tự được phát triển từ những năm 1970 tại đại học California ở 

Berkeley 

Pspice ( Power Simulation Program with Integrated Circuit Emphasis ) được phát triển bởi hãng 

MicroSim, là một trong những phiên bản thương mại được phát triển từ Spicevaf trở thành phần mềm 

mô phỏng phổ biến nhất trên thế giới. Pspice cho hép chúng ta mô phỏng các thiết kế trước khi di vào 

xây dựng phần cứng. CHương trình mô phỏng cho phép chúng ta quan sát họa động của mạch cũng như 

những thay đổi của các tín hiệu đầu vào hoặc các giá trị của các thành phần trong mạch điện. Do đó có 

thể kiểm tra lại các thiết kế để xem chúng có chạy đúng trong thực tế hay không. Pspice chỉ mô phỏng và 

tiền hành các phép đo kiểm tra chứ không phải là phần thiết kế của mạch điện 

4.1.2 Các tính năng của Pspice 

Pspice được đưa ra thị trường nhiều phiên bản khác nhau, mỗi phiên bản cung cấp các tính năng khác 

nhau tùy thuộc vào yêu cầu khách hàng. 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 4. Mô  phô ng PSPICE 

 

Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông  Tp.HCM  78 

Trong phần này, tôi sẽ hướng dẫn dùng phần mềm Pspice A/D đi kèm trong bộ phần mềm OrCAD  

Pspice A/D là chương trình dùng để  mô phỏng các mạch điện tương tự và số. Các tính năng chính của 

Pspice A/D: 

- Phân tích xoay chiều, một chiều, quá độ : Tính năng này cho phép chúng ta kiểm tra các đáp 

ứng cảu mạch điện khi được cung cấp đầu vào khác nhau. Cụ thể :  

+ Phân tích một chiều ( DC Analysis ): Cho phép xác định điện áp định mức và trị số dòng điện 

cho tất cả các nút của mạch bằng cách quét toàn bộ giá trị của điện áp trong một khoảng do 

người dùng định nghĩa. Điều này có ý nghĩa khi muốn xác định đường đặc tính của các mạch 

điện có chứa các phần tử phi tuyến như: diode, transistor,.. hoặc muốn xác định điện thế định 

mức của các mạch khuếch đại 

+ Phân tích quá độ ( Transient Analysis ) : nhằm dự đoán các trạng thái của mạch khi có các sự 

kiện quá độ xảy ra 

+ Phân tích xoay chiều ( AC Analysis ) : mô phỏng hồi đáp tần số của mạch điện, tức là ta có thể 

quan sát được các trạng thái của mạch điện khi tần số của nguồn điện thay đổi trong một dãy 

cho trước. Dựa vào đó đó ta có thể tìm thấy tần số cộng hưởng của mạch 

- Phân tích tham số, độ nhạy, giá trị giới hạn : với những tính năng này chúng ta có thể quan sát 

những biến đổi của mạch điện khi thay đổi các giá trị của các thành phần của nó 

- Phân tích thời gian của các mạch số cho phép tìm ra sự cố về thời gian xuất hiện khi kết nối các 

tín hiệu có tần số thấp trong quá trình truyền dẫn tín hiệu 

Pspice A/D cũng cung cấp các mô hình hóa về các ứng xử của các thiết bị tương tự và số, vì vậy chúng ta 

có thể mô tả các hàm chức năng của mạch điện sử dụng các biểu thức và hàm toán học. Do đó có thể 

xây dựng và phân tích các đặc tính phức tạp của thiết bị thông qua mô hình toán học. Các mô hình hóa 

được xây dựng trong Pspice A/D không chỉ là các điện trở, điện cảm, điện dung mà còn có các mô hình 

sau : 

- Mô hình dây dẫn, bao gồm độ trễ, độ dội, tổn hao, tán xạ và tạp âm 

- Mô hình của cuộn dây từ phi tuyến, bao gồm độ bão hòa và từ trễ 

- Mô hình của MOSFET 

- Mô hình của transisitor trường có cực điều khiển cách ly IGBT MOSFET 

- Mô hình của các phần số với vào ra tương tự 

4.2 Các bước tiến hành mô phỏng và phân tích mạch điện 

Để khảo sát một mạch điện nói chung cũng như một mạch điện tử công suất nói riêng ta tiến hành theo 

các bước sau: 

- Xác định mô hình các phần tử cần thiết để xây dựng mạch điện. Đa số các phần tử này đều có 

trong thư viện mô hình của chương trình, tuy nhiên trong một số trường hợp ta phải xây dựng 

thư viện mới. Việc xây dựng mô hình mới đòi hỏi am hiểu sâu sắc về kỹ thuật điện- điện tử bởi vì 

mô hình phải phản ánh đúng đặc điểm và tính chất vật lý của thiết bị thực. Mô hình càng gần với 

thực tế thì kết quả phân tích càng đáng tin cậy. Mặc dù vậy, trong một số trường hợp, khi khảo 
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sát một số đặc tính nào đó thì ta chỉ cần mô hình hóa các tham số, thông số liên quan đến đặc 

tính đó, tránh gây ra những phức tạp không cần thiết 

- Thiết lập sơ đồ nguyên lý của mạch điện cần nghiên cứu. Cần phải đảm bảo chắc chắn rằng sơ 

dồ nguyên lý được xây dựng là đúng đắn 

- Chuyển đổi từ chương trình nguyên lý sang chương trình mô hình hóa theo ngôn ngữ chuyên 

dụng của phần mềm ( đối với phiên bản hiện tại của Pspice thì việc này là hoàn toàn tự động ). 

- Thiết lập các thông số của sơ đồ và các tham số khảo sát 

- Tiến hành khảo sát: 

+ Chạy thử chương trình với chế độ quen thuộc mà kết quả đã biết trước để kiểm tra độ chính 

xác của mô hình 

+ Khi mô hình hoạt động đạt độ tin cậy thì ta tiến hành nghiên cứu vói các chế độ cần khảo sát 

theo yêu cầu đặt ra 

Cụ thể với Pspice A/D trong OrCAD ta tiến hành theo 3 bước: 

- B1: Thiết kế mạch bằng CAPTURE 

+  Tạo một dự án Analog Or Mixed A/D 

+ Đưa vào các phần tử 

+ Nối dây và hoàn chỉnh sơ đồ mạch 

- B2: Xác định kiểu mô phỏng 

+ Tạo tệp tin mô tả 

+ Xác định kiểu phân tích: 1 chiều, xoay chiều, quá độ, thời gian, tần số 

+ Chạy PSPICE 

- B3: Quan sát kết quả: 

+ Thêm các đường đồ thị 

+ Phân tích dạng sóng 

Kiểm tra tệp tin đầu ra nếu cần 

+ Lưu và in kết quả 

4.3 Thiết kế mạch bằng CAPTURE 

Về phần Capture tôi đã hướng dẫn cụ thể cho các bạn ở phần trên, nên phần này tôi chỉ hướng dẫn 

những gì liên quan tới Pspice. 

4.3.1 Tạo 1 project mới 

Khởi động cửa sổ làm việc của Capture. Chọn File -> New -> Project để tạo project mới 

Cửa sổ New project xuất hiện 
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Trong cửa sổ này, bạn gõ vào tên tập tin trong phần Name, chọn thư mục để lưu trữ tập tin trong phần 

Location. Trong thẻ Create a New Project Using bạn đánh dấu vào ô tròn thứ nhất : Analog or Mixed 

A/D. Nhấn Ok để đồng ý tạo Project mới 

 Lúc này trình Capture mở ra một cửa sổ Create Pspice Project, bạn hãy chọn mục Create a blank 

Project để trình Capture mở ra trang vẽ trắng 

 

OK để hoàn tất và vào vùng làm việc chính của Capture 
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Với việc liên thông với trình Pspice A/D thì thanh Capture có thêm thanh công cụ để hỗ trợ cho việc liên 

thông với Pspice 

 

Ở đây tôi sẽ mô phỏng mạch dao động sử dung IC định thời 555, loại IC này được dùng rộng rãi trong 

mạch điện tử tương tự. Sơ đồ nguyên lý của 1 mạch tạo xung dùng 555 như sau: 

 

Các bạn thực hiện việc lấy linh kiện và đi dây để hoàn thiện mạch như hình trên 

 Lưu ý: 

- Thư viện để sử dụng cho trình mô phỏng  Pspice được lấy trong thư viện pspice theo đường dẫn 

mặc định là: \capture\library\pspice 

Một số thư viện thông dụng dùng trong mô phỏng Pspice bao gồm: 

Các linh kiện có trong mạch: 

IC 555/ ANL-MISC.OLB 

 R/analog 

 C/analog 

 VDC/source 

 GND 
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 Analog: chứa các phần  tử thụ động ( R,L,C ), hỗ cảm, đường truyền và các nguồn dòng, nguồn áp phụ 

thuộc( nguồn áp phụ thuộc điện áp E, nguồn dòng phụ thuộc dòng điện F, nguồn dòng phụ thuộc dòng 

điện G và nguồn áp phụ thuộc dòng điện H ) 

 Source: bao gồm các loại nguồn dòng và nguồn áp độc lập như  VDC, IDC, VAC , IAC , VSIN ,VEXP, xung,... 

Và nhiều thư viện khác chứa các thành phần của mạch điện như các linh kiện điện tử công suất: diode, 

transistor, thyristor, mosfet, các cổng logic, các thiết bị giao tiếp 

- Các điểm nối của mạch được đánh dấu bằng các số nguyên dương, trong đó bắt buộc phải có 

nút số 0 và luôn được hiểu là điểm đất ( Ground ). Điểm 0 này rất quan trọng vì khi chạy chương 

trình máy sẽ tính toán điện áp giữa mỗi nút trong mạch điện với điểm đất này trong từng bước 

tính 

Để lấy điểm 0 ta kích chuột vào biểu tượng  bên thanh công cụ hoặc nhấn phím G. Hộp thoại Place 

Groud hiện ra, ta chọn thư viện SOURCE và chọn ký hiệu 0 

 

- Việc vẽ mạch bằng Capture để phục vụ cho trình mô phỏng Pspice phải tuyệt đối chính xác từ 

việc chọn linh kiện đến nói dây và các thông số linh kiện, như vậy việc mô phỏng mới đảm bảo 

được 

- Với các mạch dao động bạn phải đặt vào mạch một điều kiện khởi đầu ( lênh IC: Initial 

Condition). Hãy mở của sổ Place Part và chọn thư viện Special rồi chọn tên linh kiện là IC1. Bạn 

hãy nhấp chuột lên chữ “ IC” để ghi vào mức volr khởi đầu ( vd : 0V ). 

4.3.2 Hoàn thiện bản vẽ 

Sau khi hoàn tất việc lấy linh kiện và đi dây, cần phải gán tên và giá trị cho các phần tử 
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Các nút lưới: Danh sách các nút lưới bao gồm toàn bộ các phần tử của mạch được liệt kê theo cấu trúc 

đã được quy định. Để tạo ra các nút lưới từ sơ đồ mạch nguyên lý, ta dùng lệnh Pspice -> Create netlist    

từ thực đơn của chương trình. Danh sách này được lưu trong tệp tin có đuôi .net và được quản lý bằng 

trình trình quản lý dự án, ta có thể chọn vào tệp tin này để xem nội dung bên trong của nó. Và đây là nội 

dung của tệp tin ứng với mạch đang xét:  

nếu có thông báo lỗi , bạn hãy kiểm tra lại sơ đồ mạch cho đến khi nào không xuất hiện lỗi nữa thì chúng 

ta tiến hành xác định kiểu phân tích và mô phỏng 

4.4 Phân  tích và mô phỏng 

4.4.1 Xác định kiểu phân tích và mô phỏng 

Trước hết hãy nhập chuột vào biểu tượng  để mở trang phân tích mạch. Cửa sổ 

New Simulation xuất hiện: 

gõ vào ô Name tên của trang phân tích. Nhấn phím Create để mở cửa sổ chọn kiểu dạng phân tích. Giao 

diện như sau: 
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Trong thẻ Analysis, mục Analysis type có 4 lựa chọn kiểu phân tích chính: 

- Bias poit: dùng xác đinhj điều kiện phân cực DC của một mạch điện. Tính toán xong,  ta sẽ có các 

mức áp DC trên các đường mạch và có dòng điện chảy qua các nhánh của mạch 

- DC Sweep: dùng quét thông số DC để phân tích các đặc tính của các linh kiện điện tử. Như vẽ 

các đường cong đặc tính của diode, transistor, scr, triac, các cổng logic,..Khảo sát mạch với các 

mức nguồn nuôi DC khác nhau... 

- Time Domain ( Transient ): dùng phân tích các mức áp trên các điểm của mạch điện lấy theo 

biến thời gian ( ở đây trục X lấy theo biến thời gian ). Nó có công dụng như bạn đang dùng một 

máy hiện sóng nhiều tia để xem các tín hiệu trên các điểm nối của mạch điện. 

- AC Sweep/Noise: dùng phân tích các mức áp trên các đường nối của mạch điện thoe biến tần số 

và góc pha ( trục X lấy theo biến tần số hay biến góc pha ). Nó dùng để vẽ ra đường cong đáp 

ứng biên tần, pha tần của mạch. 

4.4.2 Thực hiện mô phỏng 

Trong ví dụ trên, ban đầu bạn hãy chọn cách phân tích là Bias Point và nhấn OK để đồng ý 

Chọn Pspice -> Run ( hoặc biểu tượng  trên thanh công cụ ) 

Để quan sát kết quả của quá trình mô phỏng phân tích 1 chiều, ta có thể mở tệp đầu ra hoặc quay trở lại 

sơ đồ mạch và kích vào biểu tượng  ( cho phép hiển thị điện áp dịch )hoặc ( dòng điện dịch ) 

hoặc  ( công suất tiêu tán trên các phần tử ) 
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Kết quả của quá trình phân tích: 

  

 

Tiếp theo chúng ta chọn cách phân tích Transient ( Trục X lấy theo biến thời gian ). ở dạng phân tích này 

bạn chỉ cần gõ số vào các ô trống ( xem hình ): 

 

Điện áp định thiên 
Dòng điện định thiên 

Công suất tiêu tán 
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Trong ô Run to time : gõ vào khoảng thời gian phân tích 

Ô Start saving data after:  xác định thời điểm bắt đầu cho hệ tín hiệu 

Ô Maximum step size: chọn bước in ( bước in càng nhỏ thì tín hiệu in ra sẽ càng net, hình càng đẹp 

nhưng tập tin dữ liệu ghi lại trên đĩa sẽ lớn và thời gian phân tích sẽ kéo dài hơn ). 

Sau khi đã chọn xong thì nhấn phím OK để trở lại trang vẽ. Chọn đầu dò Volt  và gắn vào vị trí của 

chân ra OUTPUT số 3 của IC 555. Nhấn chọn Run để xem kết quả phân tích: 

 

Trong trang đồ thị này, chúng ta thấy tín hiệu ra trên chân số 3 của IC555 có dạng xung vuông. Lúc này 

muốn xem tín hiệu trên điểm nào của mạch điện thì đặt ống dò ngay trên điểm đó. 

Nếu như cùng lúc bạn đặt ống dò trên 2 chân số 6 và số 3. Chúng ta sẽ thấy tín hiệu trên chân 3 là dạng 

xung vuông, còn trên chân 2,6 là dạng tín hiệu răng cưa, cả hai cùng hiện trên 1 đồ thị 
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Kết quả mô phỏng:  

 

 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 4. Mô  phô ng PSPICE 

 

Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông  Tp.HCM  88 

Bạn có thể thay đổi trị số của các linh kiện trên mạch điện rồi cho phân tích bạn sẽ thấy kết quả khác. 

Trên vùng làm việc của Pspice, bạn nhấp chuột vào 2 trục của đồ thị để thay đổi tọa độ và lưới hiển thị 

sao cho phù hợp với nhu cầu của bạn 

Bạn cũng có thể xem các đường biễu diên khác. Mở của sổ add trace bằng lệnh Trace -> add trace... 

hoặc biểu tượng  trên thanh công cụ. Trong cửa sổ Function or Macro, bạn chọn hàm cần xem, 

trong thanh Trace Expression chọn biến cần quan sát, nhấn OK để xem: 
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Ngoài ra bạn có thể chọn chế độ quét DC_Sweep để phân tích các đặc tính của linh kiện. 

 

 

trong thẻ Name chọn nguồn 

cần đo ( ở đây là nguồn V1) 

Start Value: giá trị khởi đầu 

End value: giá trị kết thúc 
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Đây là phần mềm mô phỏng mạnh và được dùng rất phổ biến. Và để sử dụng được phần mềm này một 

cách thấu đáo đòi hỏi các bạn phải có một kiến thức chuyên sâu về kỹ thuật điện tử. Trong phần này tôi 

chỉ giới thiệu khái quát về công cụ mô phỏng Pspice để các bạn có thể biết cách mô phỏng một số mạch 

điện tử phục vụ cho việc học tập của mình.  Việc dùng Pspice để phân tích độ nhạy, phân tích nhiễu, 

phân tích Fourier, phân tích tham số, phân tích nhiệt độ, mô phỏng số,...và nhiều vấn đề khác tôi sẽ 

không đề cập đến trong tài liệu này. Nó sẽ được hướng dẫn chi tiết, thấu đáo trong một tài liệu khác 

chuyên biệt để có thể giúp bạn có thể đi sâu vào khai thác phần mềm mô phỏng Pspice. 
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Chương 5: Một số bài tập ví dụ 

Phần này sẽ giới thiệu các bạn một số mạch tham khảo vẽ bằng OrCAD 9.2 

5.1 Mạch nguồn 

5.1.1 Sơ đồ nguyên lý: 

 

Để cho mạch được gọn khi đi dây các bạn sử dụng chức năng “ đặt  nhãn đường mạch “ bằng cách nhấp 

chuột vào biểu tượng Place net alias  bên thanh công cụ phải 
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Đặt tên cho nhãn trong khung Alias, màu chữ trong khung Color, và muốn thay đổi định dạng chữ thì 

nhấp vào nút Change... trong khung Font  

Đặt nhãn vào vị trí đi dây phù hợp, làm tương tự cho đầu dây còn lại, các đường mạch có chung nhãn sẽ 

được tự động nối với nhau khi chuyên qua Layout Plus 

Chức năng này rất hữu dụng, nhất là khi thiết kế mạch phức tạp, sử dụng nhiều IC,... Tạo nhãn đường 

mạch sẽ cho mạch nguyên lý gọn hơn và thẩm mý hơn 

5.1.2 Sơ đồ mạch in 

5.1.2.1 Sắp xếp linh kiện 

Các bạn có thể sắp xếp linh kiện theo hình dưới 

  

5.1.2.2 Vẽ mạch ( ở đây sử dụng chế độ Autoroute ) 

Các thông số  về độ rộng đường mạch của mạch trên được cho như hình: 
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Chọn chế độ chạy mạch in một lớp ( BOTTOM ) 

vào Auto – Autoroute, ta được như hình dưới 

 

 

 

 

 

 

 

 

 

Kiểm tra các đường mạch và chỉnh sữa lại 

nếu muốn. Sau đó chèn Text và phủ mass 

cho mạch 

Sơ đồ mạch hoàn chỉnh 
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5.2 Mạch nạp STK200/300 

5.2.1 Giới thiệu 

Mạch nạp loại này sử dụng cho các board STK200/300 của Atmel nên thường được gọi là STK200/300. 

Mạch này giao tiếp với máy tính qua cổng LPT (cổng song song). Có 2 phiên bản phổ biến của mạch 

STK200/300 đó là phiên bản thu gọn và phiên bản sử dụng IC đệm dòng 74xxx. Ở đây sử dung mạch có 

IC đệm 74HC245, mạch này nạp rất ổn định và an toàn. Mạch này được hỗ trợ bởi rất nhiều chương 

trình nạp và sử dụng được cho hầu hết các loại chip AVR. Mạch này có các linh kiện rất dễ kiếm và chi 

phí rẻ nên được dùng nhiều trong giói SV 

5.2.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình: 
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Sử dung chức năng place no connect  để đánh dấu vào các chân không đi dây. Chức 

năng  để tạo đường bus 

5.2.3 Sơ đồ mạch in 

5.2.3.1 Sắp xếp linh kiện 

Linh kiện trong mạch có thể được sắp xếp như hình dưới 

 

5.2.3.2 Vẽ mạch  

Các thông số độ rộng đường mạch tham khảo 
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Chạy dây lớp BOTTOM 

 

Kiểm tra mạch, chèn Text và phủ mass cho mạch 



Hướng dẫn sử dụng phần mềm thiết kế mạch điện tử OrCAD Chương 5. Bà i tà  p 
 

Nguyễn Ngọc Hà. Email: hanguyen92205@gmail.com 
Lớp D10CQDT01_N – Học viện Công nghệ Bưu chính Viễn thông Tp. HCM  97 

Mạch hoàn chỉnh: 

 

5.3 Mạch nạp AVR USB 910 

5.3.1 Giới thiệu 

 Nạp được hầu hết các dòng AVR và một số chíp 89S của Atmel  bằng cổng USB tiện lợi 

 Kiểm tra lỗi sau khi nạp 

 Hỗ trợ khóa chíp và lập trình fuse bit 

 Header chuẩn ISP cho kết nối thuận tiện 

 Tốc độ nạp cao, sử dụng được với hầu hết các trình biên dịch 

 Mạch siêu nhỏ gọn, bọc cách điện thuận tiện cho di chuyển, sử dụng  

 Cực kì đơn giản trong kết nối, cài đặt và sử dụng. 

 Tương thích với  Windows XP, Vista, Windows7. 

5.3.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình 
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5.3.3 Sơ đồ mạch in 

5.3.3.1 Sắp xếp linh kiện 

Có thể sắp xếp linh kiện như hình: 

 

5.3.3.2 Vẽ mạch  

Bảng thông số độ rộng đường mạch tham khảo 
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Chạy dây và hoàn thiện 

 

Kiểm tra mạch và phủ mass, ta có mạch hoàn chỉnh như sau: 
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5.4 Mạch đèn LED rượt đuổi 

5.4.1 Giới thiệu 

Đây là mạch đèn trang trí ứng dụng IC 555 và 4017 rất đơn giản nhưng hiệu ứng khá đẹp mắt. 
IC 555 đóng vai trò làm xung kích cho 4017 thực hiện đếm. Tốc độ chuyển động của đèn được quyết 
định dựa vào tần số của 555  
5.4.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình dưới 

 

5.4.3 Sơ đồ mạch in 

5.4.3.1 Sắp xếp linh kiện 

Sơ đồ bố trí linh kiện 
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5.4.3.2 vẽ mạch 

Chọn lớp BOTTOM, thay đổi độ rộng đường mạch phù hợp rùi chọn chế độ chạy dây tự đông 

 

Sau khi chạy dây tự động, vẫn còn một số đường mạch chưa chạy được, ta phải tiến hành vẽ bằng tay , 

tạo jumper cho đường mạch còn lại 

Chọn chế độ vẽ tay Edit Segmaent Mode  , nhấp chuột vào đường mạch cần vẽ, di 

chuyển đến vị trí phù hợp, chạy hết các đường mạch còn lại nhớ là các đường mạch không cắt nhau 

Trở về chế độ  Component Tool  , nhấp chuột phải, chọn thẻ New... Xuất hiện hộp 

thoại sau 
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Nhấp chuột vào khung Footprint... để tìm chân linh kiện cho via 
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Nhấp chọn OK 

Đặt vào vị trí cần tạo VIA, các jumper này khi làm mạch chúng ta phải tiến hành hàn dây 

Mạch sau khi tạo các jumper, và chỉnh sửa phù hợp như hình dưới 

 

Tiến hành phủ mass cho mạch để tạo bản mạch hoàn chỉnh, chèn text nếu muốn 
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5.5 Mạch đồng hồ số đơn giản 

5.5.1 Giới thiệu 

Mạch đồng hồ số dùng Led 7 đoạn để hiển thị giờ phút giây, sử dụng VDK AT89C52 để lập trình điều 

khiển và IC thời gian thực DS1307. Thích hợp cho những ai muốn tự làm mạch cho riêng mình hoặc tặng 

bạn bè 

5.5.2 Sơ đồ nguyên lý 

Mạch có sơ đồ nguyên lý như hình dưới 

 

5.5.3 Sơ đồ mạch in 

5.5.3.1 Sắp xếp linh kiện 

Sơ đồ bố trí linh kiện 
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5.5.3.2 Vẽ mạch 

Chọn vẽ mạch 1 lớp ( BOTTOM ), chỉnh kích thước độ rộng đường mạch phù hợp 

Autoroute mạch điện ta có kết quả như hình 
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Kiểm tra mạch, tạo via cho các jumper, phủ mass và ta có mạch hoàn chỉnh như sau 

 

 bố trí linh kiện trên board 
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5.6 Một số mạch điện tử hay 

Ở phần này sẽ giới thiệu cho các bạn một số mạch điện lý thú ( sưu tầm ) để các bạn có thể nghiên cứu 

vẽ và làm board thật. 

5.6.1 Mạch điều khiển tải bằng âm thanh 

 

5.6.2 Mạch đèn giáng sinh 
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5.6.3 Mạch tạo xung 1kHz 

 

5.6.4 Mạch bảo vệ quá áp 

 

5.6.5 Mạch khóa số 
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5.6.6 Mạch relay bảo vệ dòng 1 pha 

 

5.6.7 Mạch relay bảo vệ dòng 3 pha 

 

 

5.6.8 Mạch đồng hồ vạn niên 

Mạch này để gọn và thẩm mỹ thì các bạn nên thiết kế board 2 lớp ( TOP, BOTTOM ). 
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Khối điều khiển 

 

Khối hiển thị 
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Đây là sơ đồ mạch in tham khảo 

Khối hiển thị 

 

Các jumper 
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Khối điều khiển 

 

Các jumper 
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Chương 6: Làm mạch in thủ công 

Phần này sẽ giới thiệu các bạn cách làm board 1 lớp thủ công tại nhà từ các sơ đồ mạch in đã vẽ trên 

OrCAD Layout Plus 

6.1 Dụng cụ cần thiết 

- Panel: tấm đồng , tùy theo board để xác định kích thước ( mua ở chợ Nhật Tảo ). 

- Dung dịch ăn mòn: FeCL3 mua ở chợ, hoặc HCL, H2O2. 

- Phụ kiện: Kìm, khoan (các mui thường dùng 0.6mm 0.8mm 1mm 3mm), giấy ráp hoặc rẻ rửa bát hoặc 

cọ xoong 

6.2 Chuẩn bị bản in 

Sau khi thiết kế bạn chuẩn bị in, nếu nhà có máy in thì tốt, không có thì phiền đấy ! Nếu bạn cài Adobe 

Acrobat, MS Office 2003 hay FinePrint thì có một tiện ích máy in ảo, bạn sẽ in ra máy in ảo này rồi đem 

ra ngoài in vì tập tin được các máy in tạo ra là pdf hoặc file ảnh. Như thế cửa hàng bạn đem in không có 

OrCAD cũng không sao. Vấn đề ở đây là bạn phải thuyết phục chủ tiệm cho bạn in thôi. 

Hiện nay có một số cửa tiệm cho phép bạn in mạch file .MAX, nhưng hơi mắc. Không thì các bạn chép cái 

OrCAD protable trong USB và đem ra tiệm mở cái OrCAD chọn mở  file cần in lên và in thôi. 

Nếu bạn dùng giấy đề can thì in lên mặt bóng (mặt bóng của nó giống như mặt sau của cái nhãn vở dính 

(phần bỏ đi)). Loại này dc đánh giá cao nhất, nó đi được những đường mạch 10mil. Còn giấy hồng hà 

cũng được, nhưng bạn nên để đường mạch phải cỡ 15mil trở nên. 

Đối với những máy in mới HP1100 hay Canon LBP 800 trở nên, bạn phải chọn kiểu giấy nhẹ nhất nếu 

không mất giấy ráng chịu. Khi chọn giấy nên chọn loại giấy màu vàng, như vậy khi ủi thì sẽ thấy rõ hơn 

6.3 Ủi mạch 

Trước tiên bạn đánh sạch bề mặt tấm đồng, càng sạch càng tốt, đem rửa sạch rồi lau khô, bạn cắt tấm 

đồng thành tấm có kích thước bằng với board bạn thiết kế. Còn giấy bạn phải cắt to hơn khung để là 

xong có chỗ mà bóc. 

Để nhiệt độ bàn là ở chế độ max. Sau khi đặt bản in lên bo đồng bạn đặt bàn là, là trong khoảng 5-10 

phút, chú ý là kĩ phần mép. Để nguội. Nếu là giấy đề can thì có thể bóc, còn giấy hồng hà thì phải đem 

ngâm nước cho giấy mục ra rồi bóc đi. 

Không nên ủi lâu vì như vậy sẽ làm nhòe đường mạch, làm cong board,... 

Làm càng nhiều thì bạn sẽ tự rút ra kinh ngiệm cho riêng mình 

6.4 Ngâm mạch 

Bạn lấy một ít FeCL3  pha với nước tốt nhất là nước sôi. Pha đến khi nó bão hòa. cho vào một cái đĩa. Đặt 

tấm đồng vào đĩa, nghiêng đĩa như người ta đãi vàng nếu bạn pha với nước sôi thì khoảng 1 phút là 
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xong. Còn nước nguội thì khoảng 5 phút. Bạn thấy đồng ở phần không có đường mạch bong hết ra là 

được. Sau đó dùng cọ xoong đánh sạch. 

6.5 Khoan board 

Mũi 0.6 đề khoan chân có chân nhỏ như diode zener, mũi 0.8 là trở, 1 là diode chỉnh lưu. 3 là khoan lỗ 

bắt vít. 

Bạn đặt mũi khoan vuông góc với board, bấm công tác, cho khoan qua thì tắt, tiếp tục chuyển sang lỗ 

khác. 

6.6 Bảo vệ mạch 

Để tránh cho mạch khỏi bị oxi hóa bạn phải quét lên mạch một lớp bảo vệ. Sau khi hàn xong, bạn phủ 

lớp bảo vệ. Dung dịch bảo vệ: RP7 (hàng sửa xe máy, chợ trời cũng có), Sơn bóng , nhựa thông (có bán ở 

chợ Nhật Tảo). 

Với RP7 hoặc sơn bóng bạn phun trực tiếp vào phần có đường mạch. 

Còn với nhựa thông bạn đem đập nhỏ, đem hòa tan bằng xăng hoặc axeton (hiệu thuốc hoặc hàng 

mành), được một dung dịch dạng keo, sau đó lấy bút lông quét lên. Khi axeton hoặc xăng bay hơi thì lớp 

nhựa thông sẽ bảo vệ mạch. 

 

 


